
Cities 
You can pick up and deliver loads, according to the Demand cards you are given, in any of these cities on the 
map. Click any city name for more information.

Atlanta
Billings
Birmingham
Boise
Boston
Buffalo
Calgary
Cheyenne
Chicago
Cincinnati
Dallas
Denver
Des Moines
Detroit
Duluth
Fargo
Houston

Jacksonville
Kansas City
Knoxville
Las Vegas
Los Angeles
Memphis
Miami
Minneapolis
Montreal
New Orleans
New York
Norfolk
Oklahoma 
City
Omaha
Philadelphia
Phoenix
Pittsburgh

Pittsburgh
Portland, Maine
Portland, 
Oregon
Raleigh
Regina
St. Louis
Salt Lake City
San Diego
San Francisco
Santa Fe
Savannah
Seattle
Sudbury
Tampa
Toronto
Vancouver
Washington, 
D.C.
Winnipeg

Atlanta
Ours is the capital of Georgia and the cultural and economic center of    the southern United States. This place 
was originally ceded to Georgia by members of the Creek tribe in 1821 and laid out in 1837, when several of our 
leading citizens proposed that we build a railroad to Chattanooga. We became a full-fledged city in 1847, and 
we’ve got about 15,000 citizens living here now. (Still pretty modest for a major rail hub.)
Our immediate future looks a bit bleak. Although Atlanta will serve as a vital Confederate supply depot, it will 
soon be almost entirely burned by General Sherman's appalling scorched-earth policy. Fortunately, the spirit of 
this fair city will rise again, and the city will be rebuilt.
This city is a lovely place to visit, but you can’t pick up any loads you need in Atlanta.



Billings
This place ain’t exactly a city -- yet. But when the railroad comes through here, it ought to change things some. 
Folks around here don’t care much about fancy city stuff anyway. Here in the Nebraska Territory, we’re mostly 
cattlemen and sheep ranchers. We like it here because we can graze our herds on the wide-open grasslands of 
the Great Plains. Sure, it’s bitter cold in the winter, but the animals can stand it, and so can we.
In about 20 years, things are gonna start hopping around here. First, they’re gonna discover gold in the Black 
Hills just east of here, and that’s gonna bring in a lot of prospectors with dollar signs in their eyes. The Sioux 
hereabouts ain’t gonna like them folks much. Sitting Bull and Crazy Horse are gonna get so riled that there's 
gonna be a few lost scalps. And if that ain’t enough, a fella named Custer’s gonna try to bring in the cavalry, but 
the Sioux and the Cheyenne are gonna stop them dead in their tracks.
Come to Billings when you need cattle or sheep.



Birmingham
Our city won’t be known as Birmingham until 1870 when we become a full-fledged modern city, thanks to the 
railroads coming our way. For the time being, however, we call our town Elyton. 
Our home is settled in the Appalachian foothills where we’ve discovered rich iron-ore deposits. These will come 
in handy during that unfortunate War of Northern Aggression that will commence in a few years. They’ll soon 
build a blast furnace here to help the war effort. 
A barge canal and the Black Warrior River link our town to the Gulf of Mexico.
By the end of this century, our little town will grow to be a major iron- and steel-producing center and will be 
called the Pittsburgh of the South.
You can pick up iron and steel here in Birmingham.



Boise
French fur trappers first called this place boisé ("wooded"), but now we just call it Boise. Those early traders at 
the beginning of this century would like to have stayed, but the Shoshone Indians thought different about that 
idea and shooed them off. 
Things will stay pretty quiet until 1863, when someone will find gold. There will be no stopping folks from settling
in after that, and we will soon build both Fort Boise and Boise City. 
Since the Oregon Trail passes right through here, folks traveling west looking for gold decided that Boise was as 
far west as they’d like to go, and stayed. The place is getting big in a hurry.
We ain’t gonna sell you none of our gold, but we’d be happy to give you some of our lead.



Boston
The capital of Massachusetts was established by Puritan settlers in 1630. During the next century, it grew into an
important seaport and trading center, sending raw products from the colonies to England, and receiving finished 
products back from them. Colonists protested taxation without representation in the Boston Tea Party, which 
soon lead to the American Revolution. 
Boston in the 1850s is the metropolis of New England and a national leader in finance, education, and medicine. 
We have a thriving international trade, with fishing and manufacturing as our main industries. We’ve recently 
expanded the area of our city to make room for the waves of immigrants streaming in, first from Ireland, and 
later from Canada, Russia, and Italy.
In Boston, you can pick up loads of fish and machinery.



Buffalo
When it was still a Seneca tribe village, French explorers and traders called the nearby creek "beau fleuve" 
("beautiful river"). Europeans who settled in 1780 called this town Buffalo Creek. In 1790, the Holland Land 
Company bought the land, and in 1803 modeled a new city after Washington, D.C. (It was burned during the War
of 1812, but soon rebuilt.)
When the Erie Canal was completed in 1825, Buffalo flourished as a major distribution point between the East 
and the western frontier.
Today, in the 1850s, this city is the country’s foremost flour-milling center. (We haven’t seen anything yet -- the 
city’s industry is going to light up when hydroelectric generators at Niagara Falls are built in the 1890s.)
Pick up a load of machinery when you come to Buffalo.



Calgary
French fur traders first explored this part of Alberta about 1750, and trading posts started popping up here and 
there in the late 1700s. Since 1821, the Hudson’s Bay Company has controlled this region. 
Although folks have lived in this area for thousands of years, in 1870 the new Dominion of Canada will buy the 
company’s lands and will build an outpost here for the North West Mounted Police and call the place Fort 
Brisebois. Our town (which comes soon thereafter) will be located where the Bow and Elbow rivers meet.
Mining’s big in the mountains nearby, but because we’re farming folk we’re going to rename this place Fort 
Calgary (probably derived from a Gaelic phrase for "bay farm" or "bay pasture").
When the railway comes through about 30 years from now, this is going to turn into the biggest city in the region
-- just you wait and see!
We have both cattle and lead for you in Calgary.



Cheyenne
We’re just a bunch of old cowpokes from Texas living up here among the Cheyenne Indians. That’s why we just 
call this place Cheyenne. (Fittin’, ain’t it?) It’s wide-open country, with lots of fresh air and beautiful sunsets. 
Nothing much in the way of a town, though. When the railroad comes through here, that’ll change. In fact, this 
place will become the capital city of all of Wyoming Territory.
When you come out thisaway, you can pick up a load of cattle from us in Cheyenne.



Chicago
Everybody knows Chicago, with its fancy buildings and wide avenues. Our city is situated on the southwestern 
shore of Lake Michigan, at the mouth of the Chicago River. We recently completed the Illinois and Michigan 
canal, which has bolstered our trading and shipping industries. Railroad people are beginning to build tracks that
lead right to the city, so we can ship products even faster both east and west. And on the same rail lines, tourists
can come to and from Chicago. 
Add a Pullman car or two to your train to pick up tourists in Chicago.



Cincinnati
Our city, known in the 1850s as the Queen City of the West, is situated on two plateaus that extend inland from 
the Ohio River to a semicircular range of hills. 
Shipping along the Ohio River has always helped our economy, especially when steam navigation was 
introduced in 1811. The Miami Canal (named after the Miami Indians who used to live around here) was 
completed in 1827 and helped improve commerce and manufacturing in the city. The first railroad got here in 
1843 and made Cincinnati a pretty popular place, especially among new German settlers. These days, our city 
has about 115,000 residents.
Speaking of railroads, because we’re right on the Mason-Dixon Line, Cincinnati has become a key station on the 
Underground Railroad.
When your train comes to Cincinnati, you can pick up coal and machinery.



Dallas
Howdy, pardner! Reckon you’re looking to pick up some cotton or oil from us here in northeast Texas. Well, yup, I 
s’pose we can outfit you with what you need, though officially, no one’s gonna say we found oil around here for 
about 80 more years.
While French traders came ’round here regularly to swap with the Anadrako people in the 1700s, we cowboy 
folks have only been here since 1841. We named the place Dallas, after the vice president of the United States 
at the time.



Denver
Miners in our Mile-High City can supply you with all the lead you need. That’s not the stuff they’re really here for 
anyway -- they’re looking for gold. Haven’t found much yet, but they’re a tenacious lot and I betcha they find 
some. If they do, I hope they keep it quiet. Too many people crowding in here is just gonna cause trouble with 
the Indians who say their ancestors the Anastazi came here 1500 years ago. They’re not too keen on seeing a 
bunch of greedy white folks mess up this beautiful place just to find a lot of shiny rocks.



Des Moines
Fort Des Moines was built at the junction of the Raccoon and Des Moines rivers by the federal government in 
1843. We became a city and the new state capital in 1857. The city is named for the Des Moines River, probably 
from the French phrase for middle (de moyen), because it flows through the land midway between the Missouri 
and Mississippi rivers.
We grow a lot of corn and raise swine here in Iowa. You can pick up your load next time you come by.



Detroit
A fort and trading post was established here in 1701 by the French sieur de Cadillac to fend off the British. The 
name Detroit is from the French phrase "d’étroit," meaning "of the strait," which was taken from the original 
settlement’s full name, Pontchartrain d’Étroit. For about 100 years, French, British, and a confederacy of Great 
Lakes and Ohio Valley tribes all fought at this site to drive the others out.
In 1815, Detroit became a city and flourished when steam navigation began soon thereafter on the Great Lakes. 
When they opened the Erie Canal in 1825, it reduced travel time between New York and Detroit to one-tenth of 
what it had been, and boosted the city’s importance. When Michigan became a state, Detroit was its first capital.
These days we manufacture just about everything, including iron and steel, stoves, wheels and axles, leather, 
engines, and ships. They say we’ve got the industrial diversity and on-hand capital to be the home for the next 
revolutionary industry. Supposed to be something that drives the whole country! Not sure what they mean by 
that...
When they roll down the assembly line in about 50 years, you can be the first to pick up cars in this city.



Duluth
You’ll find Duluth at the western end of Lake Superior, on the mouth of the St. Louis River. Our city shares an 
excellent harbor with Superior, Wisconsin. 
In 1852, we settled here in what used to be a French trading post (named after the French trader, Daniel 
Greysolon, sieur Duluth). In 1855 we’ll be opening the Soo Locks at Sault Ste. Marie, Michigan. Some day soon, 
we plan to cut a ship canal to improve access to the lake, and beyond that, all the way to the Atlantic.
The port freezes over in the winter months, but you can pick up iron and coal by train anytime.



Fargo
Here in Dakota country, we have a quiet life raising our livestock and growing crops. We got plenty of oats up 
here. You can pick up a load when you come by. 
Coupla fellas named Wells and Fargo recently merged their pony express companies. Now they call themselves 
the American Express and will take parcels all across the country. We kinda like that Fargo fella around here (he’s
the company president). If we ever do get a town here, maybe we’ll name it after him.



Houston
Howdy! You’ll find Houston just north a bit from the Gulf of Mexico at the mouth of Galveston Bay. We named the 
place after General Sam Houston, who beat General Santa Anna at the battle of San Jacinto in the Mexican-
American War. 
The humid south makes it a perfect location to grow rice. We intend to make a tidy profit on our crops. Some 
folks say that some day all that oil that keeps seeping around our fields might be worth something, too. You 
never know.
You can pick up oil and rice in Houston.



Jacksonville
This area was settled by French Huguenots in 1564, and more than a century later, was taken over by the 
English. We Americans laid out a city in 1822 and named it for Andrew Jackson, who was Florida's territorial 
governor at the time. Of course, he became the president of the United States after that, and that made us all 
the prouder to be citizens of Jacksonville!
Come to Jacksonville to pick up machinery.



Kansas City
French fur traders settled here in 1821 and this place was soon called Westport Landing. Ours is a port city on 
the Missouri River. We make a good living here providing supplies for gold prospectors and homesteaders who 
stop here first before heading west along the Santa Fe and Oregon Trails. In 1850, we were chartered as the Town
of Kansas, but you’ll soon know us as Kansas City.
There are no loads for you to pick up in Kansas City.



Knoxville
In 1786, General James White led a handful of settlers to build a fort beside the Tennessee River. Then known as 
White’s Fort, it soon was named as the capital of the newly formed Territory of the United States South of the 
River Ohio. At the same time, the governor of the territory renamed the fort after his longtime friend, Secretary 
of War Henry Knox. When Tennessee became a state in 1796, Knoxville became    its capital. 
You can pick up machinery in this city.



Las Vegas
Ever since Spanish explorers arrived, this place has been known as Las Vegas ("the meadows"), referring to 
grassland they saw along these spring-fed desert streams. The Paiute Indians lived here, but more recently we 
Mormons have settled here.
We hear we might have neighbors soon -- the United States army is talking about building a fort near here.
There are no loads for you in this little gem of the desert.



Los Angeles
Great sun, great waves, beautiful mountains, beautiful people.
Los Angeles is a wonderful place for a vacation, but there are no loads to pick up here.



Memphis
Its ancient name is fitting for this city, built on the site of civilizations dating back to the 11th century. Our fair 
city was founded on the bluffs of the Mississippi River in 1819 by Andrew Jackson (who later became president) 
and two partners who named it after Memphis, Egypt. The city grew as river traffic increased, and is now one of 
the nation’s busiest ports.
In a few years, when the American Civil War begins, Memphis will become an important Confederate military 
center, and in 1862 will serve as the temporary capital of Tennessee. Unfortunately, in June of that year Union 
soldiers will capture Memphis after a river battle in which seven-eighths of the Confederate vessels will sink. 
Come to Memphis when you need a load of bauxite.



Miami
Florida was ceded by Spain to the United States in 1819 and became a state in 1845. Fort Dallas was built here 
in 1835 during the Seminole Wars and some day soon we’ll formally establish a city here.
You can pick up cattle in Miami.



Minneapolis
Situated at the head of the navigable part of the Mississippi River, we call this city Minneapolis. The    name 
comes from the Sioux "minne," meaning "water," and the Greek "polis," meaning "city" -- a reference to the 
numerous lakes and streams of the area. 
This area was originally home to the Sioux tribe, and became the site of the U.S. Army’s Fort Snelling in 1819. 
Since 1855, when the government officially opened the area west of here for settlement, westward migration has
picked up quite a bit.
Farmers in this land of many waters will supply you with corn.



Montreal
French explorer Jacques Cartier discovered the tribal village of Hochelaga on Montréal Island in 1535. The first 
permanent European settlement was established here in 1642, when the French mission of Ville Marie was 
founded on the banks of the Saint Lawrence River. Natives were reluctant to give up this beautiful area and 
illustrated this sentiment often, thus hindering significant development of the European settlement in the 1600s.
During the next century, however, it thrived as a center for the fur-trading industry. The British took over this 
area in the 1760s and, just one decade later, American troops occupied the settlement during part of the 
American Revolution. 
Montreal was incorporated in 1832 and our Canadian city attracted manufacturers and immigrants from all over 
the world.
Today, former Negro slaves are fleeing the United States to find a safe haven here in Canada. (See the 
Underground Railroad for details.)
You can pick up imports from Montreal.



New Orleans
This old French Creole city was founded in 1718 in the Mississippi Delta. The city was first the capital of the 
French colony and then of Spanish Louisiana. Early New Orleans residents fought swamps, floods, hurricanes, 
and yellow fever. Two voracious fires in the late 1700s nearly leveled the city. 
In 1800, New Orleans was secretly ceded to France, then sold as part of the Louisiana Purchase in 1803 to the 
United States. In 1812, Louisiana became a state, and naturally New Orleans was named its capital, from 1812 to
1830 and again from 1831 to 1849.
Steamboat traffic on the Mississippi River between 1810 and 1850 has made the city one of the busiest ports in 
North America; as of 1852 New Orleans is the third-largest city in the United States.
Plantation owners around this area can supply you with all the rice you need.



New York
In the 1600s, Manhattan Island was a handful of small hamlets. Since then they’ve merged to become the core 
of this country’s largest city. Both the completion of the Erie Canal in 1825 and the recent influx of immigrants 
from Europe added to our city’s vigorous growth. Between 1820 and 1840, this city’s population doubled, and by
1850, had doubled again.
Today, New York City is a major center of commodities exchange (the New York Stock Exchange was established 
in 1817), banking, marine insurance, and manufacturing.
New York’s impressive buildings are world-renowned, and we’ve recently added a wonderful park system, 
including the city’s massive Central Park, to further beautify this extraordinary place. 
You can pick up tourists in this city.



Norfolk
Whether you're a deep-water or river fisherman, you'll like it just fine here in Norfolk. This is the place where the 
James, Elizabeth, and Nansemond Rivers all feed into Chesapeake Bay on their way to the Atlantic Ocean.
Our city was founded way back in 1682. From our well-protected harbor, tall ships carried goods from the 
plantations of Virginia and North Carolina to the West Indies. The city remains a key national seaport and an 
important military center.
You can pick up fish and imports from Norfolk.



Oklahoma City
From the earliest    times, this region was inhabited by Native Americans, including the Cherokee, Chickasaw, 
Choctaw, Creek, and Seminole peoples. 
In 1889, the area will be opened to settlement with a soon-to-be-famous land run for staking out claims. In a 
single day (April 22) a tent city of nearly 10,000 inhabitants will be built at the future site of Oklahoma City. 
Wheat grows throughout this area, and oil sits yet undiscovered just beneath the surface. Help yourself to oil and
wheat when you come here.



Omaha
Our community was named for the Omaha Indians, who once lived in this area. This port of entry to the West on 
the Missouri River is brand new -- just laid out in 1854. 
This is the capital of the Nebraska Territory, and will be the capital of the future state of Nebraska. Its location, 
close to the geographical center of the United States, makes it a key transportation and trading center. These 
days, our city is an outfitting point for overland wagon trains heading west. 
Like the Omaha people before us, we are an agrarian society. Farmers in this Nebraska city can supply you with 
oats and wheat.



Philadelphia
This is the birthplace of the nation, where both the Declaration of Independence and the U.S. Constitution were 
drafted. Philadelphia was settled in the 1640s by Swedes. In 1682, with a land grant from Britain’s Charles II, 
Quaker William Penn founded a colony where religious freedom would be guaranteed. Penn and a surveyor 
general laid out the land between the Delaware and Schuylkill rivers in a 22-by-8-block grid pattern. The city 
includes four public squares, plus a larger a central square for the town hall. 
Early on, Philadelphia became a center of the abolitionist movement (see the Underground Railroad for more 
information), and in the soon-to-come American Civil War, it will serve as a major industrial supplier for the 
Union.
The Port of Philadelphia, on the Delaware River, is one of the world’s busiest freshwater ports.
Today, in the 1850s, this cosmopolitan city has half a million inhabitants.
Next time you’re in Philadelphia, pick up a load of imports.



Phoenix
Y’know, this didn’t used to be such a lonely old place. 1100 years ago, the Hohokam settled here, built a network
of irrigation canals, and farmed right here in the middle of the desert. They stayed for 600 years, and then just 
disappeared. Maybe like the mythical bird, the Phoenix, their spirit will some day rise from the ashes.
Some copper miners in this scarcely populated area can outfit you with tons of copper ore. 



Pittsburgh
Pittsburgh is situated where the Allegheny and Monongahela Rivers join to form the Ohio River. The area 
surrounding the confluence of those two rivers was claimed by both the British and the French, causing a bit of 
friction within the region.
On George Washington’s suggestion, a detachment of Virginia militia occupied this area in 1754. They began 
construction on a fort, which was soon captured and completed by the French. The British moved in and built 
Fort Pitt (1761) in honor of the then British prime minister.
In about 1792, George Anshutz built a blast furnace here, to fire our now-burgeoning steel industry. Pittsburgh 
was formally established as a city in 1816.
Come to Pittsburgh to pick up the steel you need.



Portland, Maine
This forested state to the north was originally part of Massachusetts. Portland served as Maine’s capital from 
1820 to 1832.
In years past, it wasn’t just the cold winters that we found hard here. In 1676, Portland was destroyed by Native 
Americans, and again in 1690, by the French and Native Americans. In 1775, the settlement (then part of 
Falmouth) was severely damaged by the British during the American Revolution. 
You can pick up wood in this city.



Portland, Oregon
Way out west, here on the Willamette River, not far from the Pacific, you can come to Portland, Oregon, to pick 
up copper, fish, and wood.
About 10 years ago, folks from Portland, Maine, settled here and named the place after their home town. We get 
a lot of folks through here on their way to California and Alaska looking for gold, and we do a good business 
supplying them with the things they need. But mostly, we’re a bunch of lumberjacks and fishermen around here. 



Raleigh
Following the American Revolution, the citizens of North Carolina decided to establish a centrally located 
permanent capital. Our city was laid out in 1792 and named for the English explorer Sir Walter Raleigh. It took 
two years to build the new capital (1794), which later burned to the ground (1831). We rebuilt Raleigh in 1840 
using a stately Greek revival architecture.
Raleigh has grown into a commercial and distribution center for the vast surrounding agricultural area.
You can pick up machinery and tobacco in this city.



Regina
This region is pretty quiet these days. Besides the Cree Indians, who have been here for generations, only a 
handful of cattlemen and farmers live in this area. One day we will have a regal city here. Perhaps we’ll name it 
after the Queen of England. (Regina is Latin for "queen.")
You can pick up cattle when you come to Regina. We have no idea what to do with it, so you can have all the 
uranium we mine, too.



St. Louis
Bonjour! Oui, we are very proud of our French origins. Our city was born here in 1764 as the site of a humble 
trading post. The village, named for King Louis IX of France, was built the following year. 
In 1770, St. Louis was briefly owned by the Spanish, then returned to France during the reign of Napoleon I. 
Following the Louisiana Purchase of 1803, St. Louis became part of the United States. Our city’s population has 
remained predominantly French until recently, when German and Irish immigrants discovered its beauty and 
settled here.
From the fertile land near St. Louis, we can supply you with loads of corn and swine.



Salt Lake City
We made it! After traveling more than a year, we Mormons arrived at our promised land. Joseph Smith, our 
leader and prophet, called it "the land that nobody wanted." Having been persecuted in Ohio, Missouri, and 
Illinois for our religious beliefs, we left for a new home in the west. 
Our new city, named after the Great Salt Lake, is nestled against the hills of Utah (where we’re currently seeking 
statehood). We enjoy a new life of farming, raising sheep, and mining. 
When you come to Salt Lake City, you can pick up coal and sheep.



San Diego
Hola! This deep-water harbor was discovered in 1542 by Portuguese explorer Juan Rodríguez Cabrillo. In 1602, 
Spanish navigator Sebastián Vizcaíno named the bay San Diego. In 1769, Father Junípero Serra established 
California’s first mission and first presidio (fort) here. Our community slowly developed around the presidio. 
After the Mexican-American war a few years ago, this warm, fertile region became part of the United States.
With the sun shining nearly all year long, we grow more fruit here than we could possibly eat ourselves. Come to 
San Diego and pick up a load or two of fruit or machinery.



San Francisco
The same year that the United States became a nation, our community was established and the presidio (fort) 
was built to guard the entrance to San Francisco Bay. In that same year, Father Junípero Serra established nearby
the Misión San Francisco de Asís. In the 1830s, a neighboring community was established.
The United States occupied the settlement here, then called Yerba Buena ("good herb"), from Mexico in 1846, 
and renamed it San Francisco. 
A couple of years ago, we lost the Russians as our northern neighbors. They owned Fort Ross until recently, but 
Czar Nicolas I chose to sell it rather than acknowledge the government of Mexico (which came into being, much 
to Nicolas's displeasure, as a result of revolution against a monarch). The new owner is a fellow named Sutter, 
whose name you might just recognize. He's owns the mill where they discovered the gold that started the 
California Gold Rush. (Bet the Czar was kicking himself when he heard that news!)
Since they discovered gold, our city’s population has boomed. Yep -- things are really shaking around here now! 
We import sugar and other products from Hawaii and all over the world. We also receive fruit from the nearby 
valleys. When you come here, you can pick up fruit, imports, and sugar.



Santa Fe
Buenos dias! We are happy to be a newly added part of this nation, recently ceded from Mexico after the 
Mexican-American War. 
This is a beautiful, but very old, city. Santa Fe was founded by Spaniards in 1610 as New Mexico’s capital. That 
year, our Palace of the Governors and San Miguel Mission were both built. In 1680, the Spanish were driven from 
New Mexico by the Pueblo revolt. They reconquered the region in 1692, and Santa Fe was again occupied in 
1693. Zebulon M. Pike explored the area for the U.S. government in 1807, but Spain did not relinquish control 
until 1821, when the region came under Mexican control. Tensions ensued and the Mexican-American War 
resulted. 
New Mexico was ceded to the United States in 1848, and now Santa Fe is the territorial capital. 
You can pick up coal and uranium in this city. (We don’t know what to do with uranium either -- its use has yet to 
be discovered.    But in a few years, you can bring it back to the folks at the Los Alamos research facility here. 
They’ll know what to do with it.)



Savannah
In 1733, this city was established by philanthropist General James Oglethorpe as a colony to rehabilitate 
imprisoned debtors through profitable labor. Thus was born the last of the 13 American colonies.
Savannah became one of the first planned cities in the country, designed with a series of public squares, where 
each family’s residence directly faces one of the squares.
In 1793, a tutor on a Savannah plantation named Eli Whitney invented a mechanized way of "ginning" cotton 
seeds from the cotton bolls. Although rice was a popular crop in this area until that time, plantation owners were 
soon growing cotton instead, making this area a leader in cotton production.
You can pick up cotton and tobacco in this city.



Seattle
Our founding fathers recently arrived by boat to this beautiful place between the Puget Sound and Lake 
Washington in the shadow of Mount Rainier and within view of two mountain ranges. This area is full of natural 
beauty. And rain. Lots of rain.
Seattle is a newly-settled city with a bright future, but there are no loads here. Not yet anyway.



Sudbury
Situated in southeast Ontario, Sudbury won’t be officially founded in 1883. We anticipate the discovery of great 
mineral deposits here. 
You can pick up nickel in this city.



Tampa
Some say that Tampa was named by an Indian who saw a man with a cigar. The word means "sticks of fire" in 
the Caloosa language. 
It’s true that a few folks around here make some wonderful cigars by hand, but what we’ve got most of around 
here is fruit trees. Oranges, grapefruits, any kind of citrus -- we’ve got it all.
When you need a load of fruit, come to Tampa.



Toronto
Toronto is a Huron word for "meeting place."
This place is located where the Humber and Don Rivers run into Lake Ontario. In the 1600s, it was used by 
Indians and French fur traders as an overland shortcut between Lakes Ontario and Huron. In the mid-1700s, the 
French Fort Rouille was built here. Later, British Loyalists who came north after defeat in the American Revolution
settled here. 
Then called York, the city became the capital of the British dependency and soon grew as a transportation hub 
and commercial center.
You can pick up cars and machinery in this city. (Now how’s that for service, eh? Cars haven’t even been 
invented yet!)



Vancouver
British explorer George Vancouver sailed through the waters of this region in 1792. A year earlier, the Spanish 
explorer José Maria Narvaez visited the area. The Salish tribe remain the predominant residents in this area, but 
soon (1865) a white settlement between the rugged Coast Mountains and the Burrard Inlet will be established 
and named for Captain Vancouver.
You can pick up fish and nickel in this city.



Washington, D.C.
In 1800, the nation’s governmental seat was moved from Philadelphia to this newly designed city. Pierre L’Enfant
created a grand plan for a city bounded by the Potomac and Anacostia Rivers and on the north by the present 
Florida Avenue. It was originally called Federal City, but renamed by Congress for the nation’s first president.
When Washington was born as a city in 1800, it was a town of fewer than 5000 people. Now in 1850, the District 
of Columbia has a resident population of nearly 52,000.
Come visit this city on your day off. There are no loads to pick up here.



Winnipeg
This area was once populated by Assiniboine and Cree Indians, but now we farmers of the Canadian prairies live 
here. Over the years, a series of forts have been built here: first the French-Canadian Fort Rouge in 1738, then 
Fort Gibraltar in 1810, and Fort Garry (built by the Hudson’s Bay Company) in 1822.
Scottish and Irish immigrants settled in the area in 1812, and the community (to be named Winnipeg in 1870) 
slowly developed as a fur-trading and distribution point.
You can pick up oats and wheat in this city.



Loads to pick up and deliver
You can pick up and deliver any of the following loads when a city requests it on a Demand card. 



Bauxite
This is the metal from which aluminum is made. High-grade bauxite is used to line furnaces, which in turn are 
used to heat homes, forge steel, and fuel locomotives.
If you're not near Les Baux, France, where Napoleonprobably got his bauxite, you can pick up bauxite in 
Memphis.
(*They say that Napoleon had plenty of silverware, but preferred the more expensive aluminum.)



Cars
Being a forward-thinking railroad owner, you know that someday cars will be a lucrative load from either Detroit 
or Toronto.
Karl Benz invented the automobile in the 1880s in Germany. In 1908, Henry Ford began manufacturing Model T 
Fords using his revolutionary assembly-line technique.



Cattle
Sunday-night pot roast dinner (with a big glass of milk and some cheddar cheese for the apple pie) depends on 
you picking up cattle in Billings, Calgary, Cheyenne, Miami, or Regina.
By the 1800s, population densities forced farmers and ranchers to move west, but this caused some food 
shortages along the seaboard. Cattlemen, however, found that they could drive cattle from places as far as Iowa 
to the eastern seaboard without harm to the herds, and with a nice profit to boot.
These days, cattlemen are discovering the abundant grasslands of the Great Plains. They’ve also found that the 
cows can withstand the bitter winters there. Although cattle drives are still possible, sending livestock to market 
on the rails is much quicker.



Coal
The Industrial Revolution is literally being stoked with this important commodity. In the old days, mules used to 
drag barges of coal down the canals from Pennsylvania to New York and New Jersey. 
In 1856, folks in England discovered that coal could be used to create the world’s first synthetic dye. 
Though you probably don’t know it now, coal production will increase more than tenfold between 1860 and 1890.
You can pick up coal from Cincinnati, Duluth, Salt Lake City, or Santa Fe.



Copper
Copper from Phoenix and Portland, Oregon is used to manufacture coins, electrical wire, plumbing fixtures, 
roofing supplies, photographic plates, and cooking utensils. It’s also a key element in the production of brass, 
bronze, and paint pigments.
J. P. Morgan, Charles M. Schwab, and Meyer Guggenheim are all famous names from the copper industry.



Corn
There’s a lot of hungry livestock in the Midwest, and a lot of hungry people around the country. You can pick up 
corn in Des Moines, Minneapolis, and St. Louis.



Cotton
Cotton clothes this nation. A New York gentleman can stroll to any of a number of stores to buy a new shirt. 
Ladies can purchase fabric to sew dresses at home.
The first U.S. factory was a cotton mill built in Rhode Island in 1790. Since then, cotton mills and textile factories 
have been popping up all along the eastern seaboard. 
Cotton seed is also in high demand. It is used for cattle food and to produce oil.
Cotton is available in Dallas and Savannah.



Fish
Fish canneries send the ocean’s bounty throughout the country. Pick up this load in Boston, Norfolk, Portland, 
Oregon, or Vancouver.



Fruit
Bring products from the sunshine states to the heartland by picking up this load in San Diego, San Francisco, or 
Tampa.



Imports
Whether it's Parisian perfume, Swiss pocket-watches, or Chinese silk, we know a good deal when we see it, and 
often buy raw materials and finished products from countries overseas. You can pick up imported loads from 
these key port cities: Montreal, Norfolk, Philadelphia, and San Francisco.



Iron
Iron is an important element in manufacturing steel. Factory parts, decorative fences and fireplace grates, and 
the rails your train runs on are all forged from this important element.
It’s still a little early for you to realize this, but iron production will increase nearly elevenfold between 1860 and 
1890, and by 1910 U.S. production of iron and steel will outpace that of Europe’s major players (England, France,
Germany, and Austria-Hungary) combined. 

Pick up iron in Birmingham or Duluth.



Lead
This versatile element is found throughout the modern American home. Beautiful lead windows decorate the 
front room, and lead weights allow handy double-hung windows to glide open and shut with ease! Paint made 
with a lead additive decorates each room, and lead crystal goblets grace the dining table. Mothers wash up 
supper dishes with water brought into the home through lead pipes joined together with lead solder. Children do 
their schoolwork with lead pencils, and afterward play with lead soldiers. Fathers read the evening newspapers, 
which were printed using lead typesetting forms.
This load is available in Boise, Calgary, and Denver.



Machinery
Preassembled machines are needed by homes and businesses across the country. 
Pick up machinery in Boston, Buffalo, Cincinnati, Jacksonville, Knoxville, Raleigh, San Diego, and Toronto.



Nickel
Nickel is used to manufacture coins, to plate surfaces, to create steel alloys, and to manufacture shell casings.
This load is available in Sudbury and Vancouver.



Oats
So long as people travel by horse and mule, there will be a huge need for oats in the cities of North America. Pick
up this load in Fargo, Omaha, or Winnipeg.



Oil
Oil is a fairly new commodity used as fuel and for lighting. Soon, there will be terrific demand for petroleum to 
power the cars rolling off assembly lines in the beginning of the 20th century. It will be a few years yet before 
they discover that plastic and polyester can also be made from the stuff.
This load is available in Dallas, Houston, and Oklahoma City.



Rice
In 1726, a ship needing repairs limped into Charleston's harbor. The captain paid for repairs, in part, with some 
rice seed he was carrying as cargo. Carolina farmers readily embraced the new crop, but during the 
Revolutionary War, British troops successfully destroyed this soon-to-be-country's entire rice crop. Not long 
thereafter, it was a resourceful Thomas Jefferson who smuggled rice out of France to reseed the Carolina fields.
Rice production eventually moved west as the country grew. Today Houston and New Orleans both produce this 
crop. Because this crop requires less manual labor to cultivate than sugar, many of the sugar cane fields in 
Louisiana will be replaced by rice paddies after the Civil War. 



Sheep
Wool and lamb chops come from producers in Billings and Salt Lake City. Sheep are also important for cheese 
and milk, and for products made from sheepskin.



Steel
The infrastructure of the Industrial Revolution, from factory works to bridge girders, and from rails to 
locomotives, are all made from steel.
Steel is produced in Birmingham and Pittsburgh. Pick up your load there.



Sugar
It’s true that until the Civil War, sugar is still produced in Louisiana. By the time you get there to pick it up, 
however, things have changed. After the Civil War, there weren’t enough workers left to tend the cane fields, so 
Louisiana produces rice instead. 
However, the tropical Pacific islands of Hawaii still grow plenty of sugar, and it is shipped regularly to our country.
So don’t go south; go west. Pick up your sugar load from the port city of San Francisco.



Swine
Pigs provide fresh meat to city dwellers. They’re also used for bacon, leather gloves, footballs, lard, and even 
brush bristles.
This load is available in Des Moines and St. Louis.



Tobacco
Gentlemen love their after-dinner cigars. Pick them up in Raleigh and Savannah.



Tourists
In 1859, George Mortimore Pullman invented the famous sleeping car. (The invention will be patented by him in 
1864.) Now tourists can travel to far-off cities in comfort, feeling refreshed when they arrive. They’re ready to 
board in Chicago and New York.



Uranium
This newly discovered ore has yet-to-be-discovered uses. Still, you have requests from paying customers to 
deliver this load. Don’t ask questions -- just pick up your load in Regina or Santa Fe and gratefully pick up your 
paycheck at the other end.



Wheat
Every mother bakes bread and pie crusts made from this essential crop. 
Pick up your load in Oklahoma City, Omaha, and Winnipeg.



Wood
This country is going through a growth spurt and building is booming. You can pick up loads of wood in Portland, 
Maine and Portland, Oregon.



Life in the 1850s

America in the 1850s is an exciting time. It's hard to explain just how fast-paced life has become. For 
generations before, everything stayed pretty much the same. People lived on farms, grew enough food for their 
own family, made their own clothes and furniture, and remained more or less self-sufficient until they died, 
probably in the same town where they were born.
But the Industrial Revolution is changing all that. We live in a young, bold, and modern new country ripe with 
opportunities as easy to pick as apples off a tree.
I can see you're an entrepreneuring soul with a good head on your shoulders. For the rest of them, I say (along 
with Horace Greeley) "Go west, young man," but for you, I've got different advice -- "Be the one to get them 
there."
Yep, you heard what I said. Build a railroad, son! Farmers in Iowa are aching for city duds and Boston folks want 
their corn. Folks out West have more gold than good sense and will pay almost anything for the loads you bring 
to them.
Build a railroad and make your fortune!
{button ,KL(`story')} Related Topics



An industrial revolution

Our country is young and strong. While the agrarian South revolves around plantation life, factories have 
changed us in the northern states from subsistence farmers to dapper city dwellers. Sure, there are a few kinks 
to work out of this new system (such as terribly long work hours for little pay, and dangerous conditions, 
particularly for the child workers, in some less-than-honorable factories), but overall, I tell you, life is better.
So much of what folks used to do by hand is done by machines now -- and in a lot less time.
Time. That's a word with a whole new meaning now. Folks used to schedule their lives by the seasons, planning 
when to plant and when to harvest. Now city folks carry watches to make sure they get to their jobs by a certain 
hour and minute! Folks are actually paid for the number of hours they work now. Time is crucial to a railroad too. 
On a well-run railroad, the trains always run on time.
Today's new innovations give folks hope for bigger, faster, easier travel and communication. These days, 
everyone is dreaming of what it would be like to have a transcontinental railroad. While we're at it, some say, we
should develop transcontinental communication. Imagine, a telegraph line alongside an ocean-to-ocean railroad!
Why, a fella could send a telegram to relatives all the way in California and his message would get there the very
same day! 
Folks want to revolutionize the way Americans (and eventually the rest of the world) live. Of course, because 
many also hope to get rich doing it, competition is fierce. Don't worry about that, though. I think you're up to the 
challenge. You've got the makings of an Empire Builder.



Burgeoning Growth

The country is 75 years old now, and look how far we've come. We have grown from 13 tiny colonies to a nation 
that spreads all the way to the Pacific Ocean. At the beginning of this century, the king of France needed some 
capital to fight against England, so he sold us the Louisiana Territory for $15 million -- a mere four cents an acre!.
Many Americans said it was too much money to spend, but most were proud that we immediately more than 
doubled the size of our young nation. Since then, we've continued to grow.
In the last decade or so, the northwest region (formally recognized as the Oregon Territory in 1848) has been a 
popular destination for those traveling on the Oregon Trail from Independence, Missouri. 
The annexation of Texas in 1845 riled Mexico to the point of war, but winning the Mexican-American war in 1848 
has netted us a huge amount of territory out West. The following year they found gold in California, and in 1850 
we made it our 31st state. 
Because of the country's recent expansion, you can now build your railroad from the Atlantic to the Pacific.



Migration and immigration

Folks are moving from Europe and other parts of the world to the United States in droves. In 1790, our population
was 3.9 million, and in 1830 it was 12.9 million. In just a few more decades (by 1880), we'll reach an incredible 
50 million Americans! Most of the new folks are coming from England, Ireland, Germany, and Scandinavia to the 
big cities, including Boston and New York City.
But as the cities become more crowded, folks press west to states along the Mississippi River and beyond. 
Wagon trains setting out from Illinois, Missouri, and other places are pouring into the Oregon Territory and 
California. It's a long, hard, and often perilous journey. Think how many more folks would travel west if only there
were a railroad to take them there.



North versus South

Slavery is a tricky topic for this nation. Some states say it's not right. Other states base their whole economy on 
slave labor. 
Until recently, we've kept an equal balance of slave and free states. In 1821, we had 11 free states and 11 slave 
states. It wasn't too hard to keep this balance until we doubled our territory with the Louisiana Purchase. 
At first, Missouri wanted to become a state -- a slave state. That's when the deal-making started. Congress 
admitted Missouri as a slave state, but broke off a piece of Massachusetts to admit it as a new free state called 
Maine. Then Congress passed something called the Missouri Compromise to assure that none of the rest of the 
Louisiana Purchase territory would be admitted as slave states. 
That wasn't the last of it, though. Not long after the Missouri Compromise, Congress passed the Kansas-Nebraska
Act to allow each new state's residents to decide whether they wanted to be slave or free. 
The free states still don't like the idea of there being any slave states. And the slave states feel the same about 
the free states. Knowing there's a place where Negroes can live without a white owner makes many slaves want 
to head north. Some former slaves up north have started a railroad of their own, called the Underground 
Railroad, which isn't making slave owners any happier either.



Underground railroad

Antislavery Negroes and white people from the North have created a loose network to help runaway slaves reach
a safe place in a free state or in Canada. This "railroad" was begun in the 1780s by Quakers, and it offers several
routes to freedom.

Most runaway slaves were young, single men with no attachments to the place they were leaving. When possible, 
"conductors" met them at such border points as Cincinnati, Ohio, and Wilmington, Delaware. Fugitives traveled at 
night from one "station" (farm) to the next until they reached a place where they could safely relocate.

While laws such as the Federal Slave Law of 1793 made helping runaway slaves illegal, the work of the 
Underground Railroad continued. This flagrant disregard for the law on the part of the northerners has enraged 
southern slave owners and adds to the impending clash between North and South.



The object of Empire Builder
You and up to five other rail barons are about to be locked in a power struggle that will span the continent. Build 
railroads, run trains, and make money. Empire Builder captures the entrepreneurial spirit of America during an era of
unprecedented wealth!
The first player to connect five major cities and accumulate $250 million wins! (Or set your own rules -- you can 
customize each game.)



Starting a game
Before you can play Empire Builder, you must define the rules of a game and invite other players to it. You can 
define the rules so that you play against yourself, or invite up to five other people to join you in a multi-player game.
Important    Be sure all players have accepted your invitation to play the game before you, as game creator, begin 
the game. After you start the game, only players who have accepted the invitation to play are included in the game.
The player who created the game gets the first turn. When it's your turn to play, a large "Your Turn" message 
appears.

To play a new game
1 In the Empire Builder Conference room, click the Empire Builder button.
2 Click the Create Game button to define the rules of the game, and then click OK.

The Talk window opens so you can select players to invite to a game.
3 Click the check box on the Business Card of those players you want to invite, and then click the Invite button. 

A question mark appears in the check box of each player you invited. When a player responds, a message box 
appears telling you whether the player has accepted or declined your invitation.

4 After players accept your invitation, click the Select button in the Talk window.
The Game List window appears.

5 Click the name of the game you just defined, and then click the Play Game button in the Game List window to 
launch the game.

Notes
If you save a game without inviting other players, and wish to invite them at a later time, you must select 

the saved game in the Game List window, and then click the Load Game button to open the Talk window and invite 
players.

In a new game, the player who created the game must be the first to enter the game, but in a saved game, 
players can leave and return when they want.

When the Empire Builder game screen appears, you can customize the way it looks to suit your 
preferences. 

A game with six players could take eight hours or more.



Playing a saved game

To play a saved game
1 From the Empire Builder Conference room, click the Empire Builder button.
2 Click the Start Game button.
3 In the Game List window, click the name of the game you want to play, and then click the Play Game button in 

the Game List window to launch the game.
Note    If the Game toolbar only contains the Create Game button, this means either you do not have any previously 
saved Empire Builder games, or the MPG-Net host is busy downloading game information.



Inviting players to a game
You can invite up to five other people to join you in a multi-player game.

To invite players to a game
1 From the Empire Builder Conference room, click the Empire Builder button.
2 Click the Create Game button to define the rules of the game, including how many players you want to play the 

game.
Six is the maximum number of players for a game, which means you can invite up to five other players. You 
don't have to wait to hear from other players before starting a game. If you don't wait, you receive a warning that
invitations are still pending. If you start, all pending invitations are canceled.
After you create the game, the Talk window opens for you to select players to invite.

3 Click the check box in the lower-right corner of the Business Card of those players you want to invite, and then 
click the Invite button. 
A question mark appears in the check box of each player you invited. When a player responds, a message box 
appears telling you whether the player has accepted or declined your invitation. If a player accepts, the question 
mark changes into a check mark. If a player declines, the check box is cleared. As each player accepts or 
declines, the Joined and Pending fields at the bottom of the Talk window are updated.
Note    If one or more players decline an invitation, you can invite a different player by clicking the Load Game 
button in the Game List window to re-open the Talk window.

4 After players accept your invitation, click the Select button in the Talk window.
The Game List window appears.

5 Click the name of the game you just defined, and then click the Play Game button in the Game List window to 
launch the game.



Customizing your Empire Builder screen
Empire Builder lets you customize the way your game screen looks by moving windows where you like them. You 
can also open and close certain windows. You can reset the screen to display the windows as they were when the 
game started by clicking Restore on the Window menu.
Some windows open when the game starts, and others open only when you want them. 

Windows that open when the game starts
Regional Map window-- From the Regional Map window, you can survey, build, and move.
Demand Card window-- From this window, you can view and manage the Demand cards you are currently 

dealt.
Control window-- This window displays buttons you can use to take action during your turn. At the top of 

the Control window is the Count area, which keeps track of the remaining mileposts you can move and the amount 
of track you can survey and build. 

Player windows-- For each player, a Player window is displayed.. It shows the name of the player and the 
color of that player's track and train, which are the same. You can click the face or the train to see that player's 
Demand cards, which are superimposed over yours    in the Demand Card window. You can also learn whose turn it 
is by pointing to a Player window. If it is that player's turn, the following Tool Tip appears: "It is currently this 
player's turn."

Your Player window-- This window shows the same information for you as other Player windows do for 
other players. You can keep the character face you start with, or change your character face. It also shows how much
money you currently have (in millions). When it's your turn, the light of the rail-crossing signal in this window turns
green. 

Other windows you can open
You can optionally open and close the following windows:

Global map
Debt window
Telegraph window 

Notes
If you borrow money, the Debt window appears at the beginning of your turn and remains until you pay off 

you debt. You can click it to close it.
To display both the global and regional maps, click the Toggle Map button, and then position the windows 

so that they are not directly on top of each other.
When you right-click a milepost or a train on the global map, the regional map immediately re-centers on 

that milepost or train.
If you exit a game by clicking Exit on the File menu, and then re-enter the game, your window arrangement

remains the same.



Moving windows
You can move any window, including a message window (from other players or the conductor) to any location you 
prefer.

To move a window
1 Place the cursor on the top border of the window you want to move.
2 Click and hold the left mouse button, then drag the window to where you'd like it to be located.

Note 
Some borders are thin, but each window does have a border you can click and drag.



Turning game sounds and music on and off
Game sounds and music help you keep track of what other players are doing and remind you when it's your turn. 
You can turn game sounds and music off and on. Sounds and music can be turned off or on independently of each 
other. 

To turn game sounds and music off or one
Click the Sounds or Music on the File menu.

If you exit and return to a game, the sound and music options you last chose are restored. 



Chatting with other players
You can chat with other players in a game by opening the Telegraph window.    The Telegraph window is also where 
messages from the Empire Builder Advisor appear.    These messages let you know if you make a mistake and 
provide other game information. 



Turning Tool Tips on or off
When you point to a specific button or feature of the Empire Builder screen, a message appears telling you what it 
is. You can turn on and off these messages by clicking Tool Tips on the Help menu.



Changing your character face

To choose your character face
1 Click the character face in Your Player window. This opens a window of characters from which you can choose.
2 Click any face to change the one used to represent you in the game.

Note    You cannot change your persona's name after the game is started. 



Exiting or resigning from a game
You can exit a game before you are done playing and come back to it another time, or you can resign from a game, 
which means you will be permanently removed from the game.

To exit or resign from a game
Click the File menu, and then click either Exit or Resign.

Notes
When you exit a game, your face in the Player window and Telegraph window appears gray to other 

players.
When a player resigns from a game, other players skip that player's turn for the remainder of the game and 

the resigned player's loads are returned to the cities. Demand cards are    discarded, and his or her train is removed 
from the global and regional maps. 

Because a resigned player's tracks remain, it is still possible for the player to win a game if other players 
ride on the tracks and pay the resigned player enough money to win.

If a player exits or loses their MPG-Net connection without moving the train or building tracks, it remains 
his or her turn. If a player exits or loses a connection after building or moving, it is the next player's turn. 



Winning a game
The first player to meet the winning conditions specified when the game was created wins. The winning conditions 
include the number of cities a player must connect with rail lines (the maximum is six) and the dollar amount (in 
millions) that a player must amass. When a player wins, a victory screen is displayed. You can close the screen and 
look at the game before you exit.
Note    After you win a game, you receive an email message with your winning statistics, which you can save in your
Briefcase.



Defining the rules of a game
From the Empire Builder conference room, you can create a new game and invite others to play. When you create 
the game, you set the game rules. 

Quick Start games
By default, game rules are set to Quick Start games. These games are designed to allow each player to build a larger 
railroad initially, before placing and moving trains. In a Quick Start game, each player begins with $60 million 
dollars rather than $40 million in regular games. Players also spend the first three turns, rather than the first two, 
surveying and building their railroads. Then, on the fourth turn, players start their trains.

To create a new game and define game rules
1 Click the Create Game button.
2 In the Create Game Options dialog box, type a name for the game you are defining.
3 Specify the number of players that can join the game. The maximum is six.
4 Each player usually begins a game with $40 million, but you can begin with more.
5 Specify winning conditions:

Type the number of cities a player must connect with rail lines in order to win. The maximum is six.
Type the dollar amount (in millions) needed to win, from $50 to $500.

Note    Empire Builder checks to see if winning conditions are met each time you build a section of track, deliver
a load, or receive money from other players.

6 To allow borrowing, click the Enable Borrowing Money check box. Then specify the dollar amount (in millions) 
that a player can borrow at a time. The maximum is $20. A player can borrow an unlimited number of times 
during each turn.

Notes  
Once you're playing a game, you can check to see how you defined the rules for that game by clicking 

Game Options on the File menu.
A game with six players could take eight hours or more to play.



Borrowing
In the 1850s, credit is rarely available. However, you can occasionally find a bank willing to loan you money, 
though usually for a very high interest rate.
When you set up game rules, you can allow players to borrow money. With this option enabled, players can borrow 
money, but they must also pay it back with 100% interest. You can keep track of how much you owe by opening the 
Debt window. If the Debt window shows you owe $10 million, only $5 million of that is available for building 
track; the remainder is what you owe in interest.
Tip  Borrow only as much as you know you can pay back in the short term. Remember -- you are borrowing at 
100% interest (that is, you must pay back double what you borrowed). If you don't think you can pay back a loan by 
the time you deliver your next load, you're usually better off tightening your belt and lowering your sights for rail 
building a notch or two.

To borrow money
On the Command menu, click Borrow $.

To open the Debt window
On the Window menu, click Debt.



Playing the game
Empire Builder is a game of strategy and competition. Each player takes a turn in order, beginning with the player 
who created the game rules and invited everyone else to play.
To play the game, you start by planning the initial route of your railroad. During the first two turns (or three turns in 
a game with Quick Start rules), you'll survey and build your railroad. On your third turn (fourth for Quick Start), 
you'll place your train in the city where you want to begin.
Note  You may only start your train in a city to which you built your tracks.
Typically, you'll place your train in a city where you can pick up a load. From there, you can begin moving your 
train toward the city that requested the load. When you get there, you'll deliver the load and collect payment. 
The money you earn allows you to continue building rail so you can connect to and deliver loads to more cities. 
The first player to connect five major cities and accumulate $250 million wins the game.
Note    The number of cities and amount of money to win may vary, depending on the specific rules set for the game 
you are playing.



Taking your turn
When it's your turn, the rail-crossing signal in Your Player window has a green light and the rail crossing bar rises. 
Empire Builder also displays the "Your Turn" message when it's your turn to play. 
Important    When your turn is over, you must click the End Turn button in the Control window so the next player 
can start. The creator of the game can force a player to end a turn by clicking the End Turn button during the other 
player's turn.
During your turn, you can:

Move your train up to 9 mileposts (all mileposts counted equally). When you upgrade your freight engine 
to fast freight or superfreight, you can move up to 12 mileposts per turn.

Pick up and deliver loads.
Spend up to $20 million either upgrading your freight engine or building track.

Tips    
Right-click any city on the regional map for its name, a description, and a list of loads you can pick up 

there.
Instead of taking your usual turn, you can discard and redraw your Demand cards. 
If a newspaper reporting a disaster displays during your turn, the consequences of that disaster take effect 

immediately.



Using the Control Window buttons
You can use the Control Window buttons to take action during your turn. Click on any area of the following 
illustration for more information.



Planning your railroad
Remember two things when planning your railroad:

You can build rail either from your existing rail line or from any major city. When you start the game, 
therefore, you must begin building from a major city.

Building a railroad is expensive, so plan with immediate revenues in mind.

To plan your railroad 
1 Study your Demand cards carefully. 

Note    You begin the game with three Demand cards showing three cities each. When you deliver a load shown 
on one of the cards, it will automatically be replaced by a new card. Make sure to review your cards before each 
turn.

2 Click a load icon on one of the Demand cards. This displays icons on the map to show you where you can pick 
up the load and where the requesting city is located. Do the same for each of the nine load icons on your 
Demand cards. 

3 Knowing that you have to begin building from a major city, choose a route connecting a city requesting a load 
with a city that can supply that load. Preferably, the distance between the two should be short.

Now you can survey and build your rail line.
Important    Survey before you build your rail line. This allows you the option of changing your mind before you 
commit your money to a particular route. 



Starting your train
On your third turn (or fourth turn in a Quick Start game), you can start your train from any city to which you built 
tracks. It does not have to be the same city as the one from which you began construction.
Tip  Start your train in a city where you want to pick up a load. Then, be sure to pick up the load before you leave 
the city.

To start your train
1 Click the Move Train button.
2 Click the city from which you want to start your train.
3 If appropriate, click the Pick Up Loads button and pick up a load in the city where you start your train.

Now you can move your train.



Surveying a rail line
By using the Survey Tracks button you can draw a proposed route for your rail line, and when you are satisfied with 
it, you can build the line.

To survey a rail line
1 Click the Survey Tracks button.
2 Click a milepost at the city limits of a major city or anywhere on your existing rail line. 
3 Continue clicking the mileposts on your proposed route. 
-or-
1 Click the Survey Tracks button.
2 Click the first milestone, then drag your cursor across the other milestones you want to connect.

Note    Remember that you can spend no more than $20 million per turn to build your rail line. However, you can 
survey more than $20 million worth of track in a turn. The track that is not built will remain surveyed until you 
either complete building the track during subsequent turns, or click the Survey Track button.



Building a rail line
You can construct new rail from any point on your existing rail line or from any major city. Because you have no rail
line when you begin the game, you must start constructing your railroad from a major city. 
You can spend up to $20 million per turn to build a section of rail. After you build $20 million worth of track, your 
turn ends automatically. The cost to build each milepost-to-milepost segment varies depending on the terrain 
between the two.
Important    Survey before you build your rail line. This allows you the option of changing your mind before you 
commit your money to a particular route. 

To build a surveyed rail line
After surveying, click the Build Tracks button. Your surveyed route will be built automatically. If you 

surveyed more than you can build for $20 million, only that portion that can be built for $20 million will be built on 
this turn.

Notes
If you do not survey before you build, your rail line will be built as you click on the map.
Only one section of track can be built between any 2 mileposts. That is, if one player has built track there, 

another player cannot.
There are certain limitations on the number of rail lines that can be built into each city, depending on the 

city's size.



The cost of building a railroad
You can spend up to $20 million per turn to upgrade your railroad. Thus, you may either upgrade your freight engine
for $20 million, or you may spend up to $20 million building track.    However, you may not build track or upgrade 
your freight engine on the same turn.
Note  Unless borrowing is allowed in your game, you must have the money on hand to pay for the track you build. 
Plastic comes later -- it's the 1850s and it's got to be cash on the barrelhead!
The following table shows how much it costs to build to specific types of mileposts. Note that it costs an additional 
amount to cross bodies of water. (For example, if you build to a clear milepost, but crossed a river doing it, it would 
cost $3 million.)

To build
Clear milepost

Mountain milepost

Small city

Medium city

Major city

Across the Great 
Lakes (at designated 
crossings only).

Across a river

Across an inlet

Price
$1 million

$2 million

$3 million

$3 million

$5 million

+ $2 million

+$2 million

+$3 million

Tip    To save money, build away from major cities rather than building into them.



Limitations on building rail to cities

Building into major cities
Every player can build at least 1 section of track to the city, but cannot block other players from building at least 1 
track. You do not have to build to the interior of a major city, just to the city limits. Use the local rail lines and 
roundhouses inside city limits. 
Note    You can build no more than two rail lines from any major city in a single turn.

Building into medium cities
Only three players can build track to a medium city.

Building into small cities
Only two players can build track to a small city.



Moving your train
You can move 9 mileposts per turn, or 12 when you upgrade to a faster freight engine. 
Beginning on your third turn (or fourth turn for a Quick Start game), you can move your train on any turn. Be sure to
move your train before building any rail line during a turn. You are not allowed to move after building. 

To move your train with the Move Train button
1 Decide which direction you want your train to travel, click the Move Train button, and then click the next 

milepost on the rail line in that direction to indicate where you want the train to move. You can move freely 
along your own rail line, or along other players' rail lines. 

2 Continue clicking each milepost one by one until you either reach your destination or run out of moves for your 
current turn.

 - or -
Decide which direction you want your train to travel, click the Move Train button, and then click any 

milepost on the rail line in that direction to indicate where you want your train to move. You train is automatically 
moved the allowable number of mileposts in that direction.
Important    Empire Builder automatically calculates the shortest route when you click a milepost that is 100 or 
more mileposts away from your starting location. This means Empire Builder will choose another player's track if 
that track brings you to your destination more quickly. To avoid track rental fees, do not click a destination 100 or 
more mileposts away that would cause Empire Builder to choose a route on another player's tracks, or that intersects 
another player's tracks. If the destination milepost is less than 100 mileposts away, Empire Builder always chooses 
the shortest route along your track.
Notes    

To cross a major city, you must click each milepost within it.
After you start your train, the Control Window defaults to the move mode when you start your turn. 
If you click a milepost beyond a major city, you will automatically move through that city. 

To move your train automatically to the next intersection or city
Click the Automove button. 

In most cases, you should click the Move button instead of the Automove button to let Empire Builder calculate 
the shortest route for you. 

Changing directions
Remember that there are no U-turns on a rail line. You can change directions in cities, but not in wide-open territory.
Only cities have roundhouses.



Traveling on another player's rail
If you don't have a rail line that leads where you want to go, you can use another player's rail line. This will cost you
$4 million per turn to each player whose track you use during that turn. 
Note    If you are moving your train by holding down the left-mouse button and the white movement line crosses 
another player's tracks, a message appears informing you of the rental fee. If you don't release the mouse button, you
can erase the white movement line by moving backwards on the track and avoid incurring fees.    However, if you 
cross the player's track with the white movement line or are traveling on the player's tracks and you release the 
mouse button, your train will move and you will automatically be charged for the track rental fees.



Picking up loads
From the Demand cards you receive, choose which load you want to pick up and drop off. Picking up or dropping 
off a load doesn't change the number of mileposts you can move in a turn.
You can pick up a load while in a city. You can pick up and carry a maximum of 2 loads (or 3 if you upgrade to a 
heavier freight engine).
Tip    Click the load icon on any Demand card to see where you can pick up and drop off a particular load. Use this 
information to help plan where you'll lay your rail and where your train will travel.

To pick up a load
1 Move your train to the city where the load is available.
2 Click the Pick Up Loads button.

This displays a dialog box showing loads you can pick up from this city.
Note    If Auto Deliver/Pickup is on, this dialog box automatically appears if you clicked the load icon on a 
Demand card and that load is available at that city. Auto Deliver/Pickup is turned on and off by clicking 
Messages on the Windows menu. Turning it on also displays game messages from the Advisor in the Telegraph 
window.

3 Click the load you want to pick up.



Delivering a load for payment
When you drop off a load to the requesting city, you'll receive the dollar amount shown on the Demand cards, and 
that Demand card will be replaced by a new card. Your account is automatically increased by the payment amount.
Note    If borrowing is allowed in the game you're playing, the amount paid for delivery reduces your debt (as shown
in the Debt window) before it increases your cash (as shown in Your Player window).

To deliver a load to a requesting city
1 After moving your train to the city requesting the load, click the Deliver Loads for Cash button.

This displays a dialog box showing the loads you can deliver for payment in this city.
Note    If Auto Deliver/Pickup is on, this dialog box automatically appears if you clicked the load icon on a 
Demand card and you can deliver the load at that city. Auto Deliver/Pickup is turned on and off by clicking 
Messages on the Window menu. Turning it on also displays game messages from the Advisor in the Telegraph 
window.

2 Click the load you want to deliver for payment.



Dropping off a load for no payment
On occasion, you'll want to pick up another load, but your train will be full. You must drop off one of your current 
loads before you can pick up a new one. 
You can drop off loads without payment at any milepost.

To drop off a load without payment
During your turn, click the Dump Loads button at any milepost.

Note    Unfortunately, there are no store houses available for you to use. Once you dump a load, you cannot return to 
pick it up later.



Upgrading your freight engine
Each player starts the game with a regular freight engine, but can upgrade to a bigger and/or faster engine.
The following table describes how fast each engine can travel per turn and how many loads it can carry:

Freight

Everyone starts out with this engine. Freight engines can carry
2 loads and travel 9 mileposts per turn.

Fast 
freight

For $20 million, you can upgrade from a freight to a fast 
freight. Fast freight trains can carry 2 loads and travel 12 
mileposts per turn.

Heavy 
freight

For $20 million, you can upgrade from a freight to a heavy 
freight. Heavy freight trains can carry 3 loads and travel 9 
mileposts per turn.

Superfreig
ht

Once you have a fast freight or a heavy freight, you can 
upgrade to a superfreight for $20 million. Superfreight trains 
can carry 3 loads and travel 12 mileposts per turn.

To upgrade your engine
1 Click the Upgrade Train button.
2 Click the type of engine you want.



Responding to reported disasters
You never know what's going to happen when you open the morning paper. Don't you wish they'd report more good 
news? Some days the news is going to affect your business. When you deliver a load and receive a new Demand 
card, or draw new Demand cards, you might trigger a disaster that will affect all players. Storms, floods, and labor 
strikes may cause some delays to your railroad.
When any player draws a Disaster card, you'll see a newspaper reporting the news. The condition explained in the 
news story remains in effect until you see the newspaper boy holding a special edition with "Disaster Over" spilled 
across the front page. 
Note    No "Disaster Over" newspaper is displayed for Derailments and Profits Tax. These two disasters impact you 
immediately and then are over.

Losing a turn
If you lose a turn as a result of a reported disaster, you cannot move or build. Likewise, you cannot get new Demand
cards during that turn. 
Simply take your lumps, click the End Turn button, and then wait for your next turn.
Other disasters require that you:
Move at half speed during a storm
Mop up after a flood
Do not move



Working with Demand cards
Supply and demand. That's the cornerstone of our capitalist society. When customers demand a load, if you can 
supply it, you get paid. It's that simple.
When you start the game, you receive three Demand cards. Each card describes three potential customers, showing 
for each the city in which the customer is located, the load the customer wants delivered, and the amount of money 
that customer is willing to pay when you deliver the load.
You can choose only one customer per Demand card to deliver a load to. When you deliver a load, that Demand card
is replaced by a new Demand card with three new potential customers.
If you don't like the Demand cards you have, instead of taking your turn, you can redraw three new cards.

To draw new Demand cards
Click the Draw Demand Cards button.

Tips 
Click any load on a Demand card to see the locations of both the requesting city (denoted by a "$" icon) 

and the cities where you can pick up that load (denoted by that load's icon). 
Click the face in an opponent's Player window to see his or her Demand cards and the loads his or her train 

is carrying.



Counting mileposts
All types of mileposts (clear, mountain, city) are counted equally when moving your train along a rail line. Their 
values differ only when building the rail line.
Be sure to count all mileposts within the city limits (for example, you must move three mileposts to move from one 
side to the opposite side of a major city).



Interacting with other players
For each player in the game, a Player window is displayed. This window shows the name of the player and the color 
of his or her track and locomotive.

What you know and don't know about other players
As you play the game, you can see the characters and rail lines of the other players. You'll know whose turn it is 
because the player's name is displayed in the information area in the Control window. You can also find out by 
pointing to another player's Player window; if it's their turn the following message is displayed: "It is currently this 
player's turn."
Important    If you survey when it is not your turn, the player's name whose turn it is will be erased from the 
Control Window information area. You cannot return to viewing turn information until your next turn.
You cannot see the amount of cash the other players have until the Rail Tax Disaster card is drawn. Then every 
player's monetary status is public information. 
You can find out what Demand cards and loads another player currently has.

To see the Demand cards for another player
1 Point to the face in that player’s Player window. 
2 Click and hold down the left mouse button.

To see the loads carried by another player’s train
1 Point to the locomotive in that player’s Player window. 
2 Click and hold down the left mouse button.

Tip    Clicking and holding down the left-mouse button on a player's face in the Telegraph window displays the 
player's Demand cards and loads.



Sending telegraph messages
While playing the game, you can send telegraph messages to other players. The Telegraph window also displays 
messages from the Empire Builder Advisor. You can open the Telegraph window by clicking the Telegraph button, 
or by just typing. 

To send a telegraph message
1 Click the Telegraph button or start typing.
2 Click the check box below the face of each player that you want to receive your telegraph, or click ALL to send 

to all players.
If you send a message to specific players without sending it to all players, the word "whispers" appears 
following the sending player's name.

3 Type a message of up to 60 characters. 
4 Press ENTER to send the message.

To turn on or off the Empire Builder Advisor messages in the Telegraph window
Click Messages on the Window menu.

Turning on or off these messages also enables or disables the Auto Pickup/Deliver message.
Notes

When sending a message to another player, you also need to check your own face in order to see the 
message in the Telegraph window.

When a player is not currently active in the game, his or her face is grayed out in the Telegraph window.



Tips and strategies
Here are some tips and suggestions related to borrowing money, building rail, using maps, managing loads, and 
moving your train.

About borrowing
Borrow only as much money as you know you can pay back in the short term. Remember, you are 

borrowing at 100% interest (that is, you must pay back double what you borrow).

About building
Be sure to survey before you build. This way, you can change your mind before you commit to any route.
It's cheaper to build FROM a major city than TO it. For example, if you build from Chicago to your 

existing rail line 3 mileposts away, it will cost $3 million (assuming no mountain or water crossings). Building from 
your existing rail line to Chicago's city limits, on the other hand, will cost $8 million.

Only 1 section of track can be built between any 2 mileposts.
Unless borrowing is allowed in your game, you must have the money on hand to pay for the track you 

build.
Click the load icon on any Demand card to see the locations of both the requesting city (denoted by a "$" 

icon) and the cities where you can pick up that load (denoted by that load's icon). Use this information to help plan 
where you'll lay your rail line and where your train will travel. Note that you can click more than one load (though 
one per Demand card) to see locations of multiple load pickup and drop-off points.

About maps
To display both the global and regional maps, click the Toggle Map button, and then position the windows 

so that they are not directly on top of each other.
Right-click a point on the global map to reorient the focus of the regional map to that spot.
Right-click any city on the regional map to see its name and available loads.

About loads
Use the Deliver Loads button, and not the Dump Loads button, if you expect payment when you deliver.
Click a load icon on any Demand card to see where you can pick up and deliver that load.

About disasters and Demand cards
There are a fixed number of disasters and Demand cards. If a game lasts long enough and the players 

encounter all of the disasters and cards, Empire Builder re-shuffles them and starts over. Therefore, you can track 
disasters to decide when it is reasonably safe to take certain actions; for example, you might decide to build a bridge 
over a river after all of the flood disasters have been drawn, knowing that the bridge might not be washed out again 
soon.

About moving
You must first click the Move Train button, and then click a milepost to which you want to move. This will 

activate the move survey mode. Then you can click the Automove Train button to move your train according to the 
move survey line.

Start your train in a city where you want to pick up a load. Then, be sure to click the Pick Up Loads button 
and pick up the load before you leave the city!



Getting technical support
If you have questions about Empire Builder that you can't answer, you can post a message on the MPG-Net 
Technical Support BBS in the MPG-Net Forum on The Microsoft Network. The MPG-Net system operator will post
a reply to your question. To connect to the MPG-Net Forum, type the Go word mpgnet



Getting more information
In addition to Empire Builder Help, MPG-Net provides several sources of information related to setting up and 
playing Empire Builder. You can download and print information about Empire Builder by double-clicking the 
Empire Builder Online Document in the MPG-Net Forum on The Microsoft Network. For information about 
inviting players and interacting in rooms in the MPG-Net Theater, click the Theater Help button on the Gold toolbar.
Note    You can turn off Tool Tips by clicking Tool Tips on the Help menu.



Move Train button

Click this button to automatically move your train based on the current active move survey line.



Move Train button
Click this button to automatically move your train based on the current active move survey line.



Build Tracks button

Click this button when you want to build rail. If you've already surveyed the route, the rail will be built 
automatically. If you haven't surveyed the route, after you click the button, the rail is built milepost-by-milepost as 
you click on the map.
Important    It's best to survey first, then build. This way, you can change your mind before you commit to any 
route.



Build Tracks button
Click this button when you want to build rail. If you've already surveyed the route, the rail will be built 
automatically. If you haven't surveyed the route, after you click the button, the rail is built milepost-by-milepost as 
you click on the map.
Important    It's best to survey first, then build. This way, you can change your mind before you commit to any 
route.



Control window

 
This window displays buttons you can use to take action during your turn.



Count area
As you move your train from one milepost to the next, this area shows how many moves you have remaining in a 
turn.



Deliver Loads for Cash button
Once you have carried a load to the requesting city, click this button to deliver the load and receive payment. 



Debt window

This window shows you the amount of debt you owe.



Deliver Loads for Cash button

Once you have carried a load to the requesting city, click this button to deliver the load and receive payment. 



Demand Card window

This window shows the three Demand cards you are currently dealt.



Doorbell button

Use this button to invite other players to play the game.



Draw Demand Cards button

Click this button when you want to draw new cards instead of taking your regular turn.



Draw Demand Cards button
Click when you want to draw new Demand cards instead of taking your regular turn.



Dump Loads button

You can dump a load at any milepost for no payment and no penalty. Click this button when you want to dump a 
load for no payment.
Important  If you expect payment for the load you are delivering, use the Deliver Loads for Cash button.



Dump Loads button
You can dump a load at any milepost for no payment and no penalty. Click this button when you want to dump a 
load for no payment.
Important  If you expect payment for the load you are delivering, use the Deliver Loads for Cash button.



Empire Builder button

Use this button to start Empire Builder.



End Turn button

Click this button when you have done all you want to do in a turn. 
Note Your turn ends automatically in some cases, such as when you draw new Demand cards, or you spend $20 
million to upgrade your train or build tracks.



End Turn button
Click this button when you have done all you want to do in a turn. 
Note    Your turn automatically ends in some cases, such as when you draw new Demand cards, or spend $20 million
to upgrade your train or build tracks.



Display Disasters button
Click this toggle button to show or hide information about those portions of the map that are affected by the current 
disasters.



Display Disasters button
Click this toggle button to show or hide information about those portions of the map that are affected by current 
disasters.



Freight engine
Each player begins the game with a freight engine. On your third turn (fourth turn in a Quick Start game), you can 
start your freight engine in any major city. (Of course, it's best to start it where you have a rail line.) You can also 
upgrade your engine to a faster and/or heavier model.

Freight engine Heavy freight

Fast freight Superfreight

Global map

This window gives you global view of the game, letting you see where you and your opponents have built track.



Invite button

In the Talk window, click the Invite button after you have placed check marks on the Business Cards of those 
players you want to invite to a game.



Toggle Map button

Click this button to toggle between the regional and global maps.



Toggle Map button
Click to toggle between the regional and global maps.



Question Mark button
Click, and then drag question mark to a part of the screen, and click again to display information about that feature.



Information area
This text box tells you whose turn it is.



Legend



New Demand Cards button
Instead of taking your usual turn (that is, moving, building rail, and/or upgrading your freight engine), you can turn 
in all your Demand cards for three new cards. If this is what you want to do, click this button.



Newspaper

This window is displayed to announce a disaster that may affect play of the game.



Loads
A load is a quantity of a certain item, such as machinery or cotton, that you transport on your train to a city needing 
that item. (You will know who needs what by referring to the Demand cards you are given.) When you deliver a load
requested on one of your Demand cards, you are paid.



Display Loads button
After you have clicked one or more loads on your Demand cards, click this toggle button to show or hide icons that 
show where these loads can be picked up and delivered.



Display Loads button
After you have clicked one or more loads on your Demand cards, click this toggle button to display or hide icons 
that show where these loads can be picked up and delivered.



Pick Up Loads button

Click this button when you want to pick up a load from the city where your train is currently located.



Pick Up Loads button
Click this button when you want to pick up a load from the city where you train is currently located.



Move Survey button

 
When you first start your train, click this button, and then click the city from where you want to start. You must click
a city to which you have built tracks. In subsequent turns, click this button, and then click the milepost to which you 
want to move. This will put you in move survey mode.    Click on the destination mileopost a second time,
or press the Move Train button to complete the move.    Pressing this button a second time will clear any move 
survey on the screen.    If your move on the previous turn has not gotten you to your destination, pressing the button 
will cause the system to move survey towards the last location selected.
In most games, you'll start your train on your third turn. In a game using the Quick Start option, you'll start your 
train on your fourth turn.



Move Survey button
When you first start your train, click this button, and then click the city from where you want to start. You must click
a city to which you have built tracks. In subsequent turns, click this button, and then click the milepost to which you 
want to move. This will put you in move survey mode.    Click on the destination mileopost a second time,
or press the Move Train button to complete the move.    Pressing this button a second time will clear any move 
survey on the screen.    If your move on the previous turn has not gotten you to your destination, pressing the button 
will cause the system to move survey towards the last location selected.
In most games, you'll start your train on your third turn. In a game using the Quick Start option, you'll start your 
train on your fourth turn.



Player windows

A Player window displays for each player in the game. This window shows a character face and the name of the 
player, plus the color of that player’s rail line and locomotive. You can click on the train or face to display a player's 
loads, which are superimposed over your Demand cards.



Regional map

This window gives you an up-close view of the area where you are building track or moving your train.



Select button

Click this button in the Talk window to open the Game List window in which you can select the game you want to 
play.



Survey Tracks button

Click this button, and then click mileposts, or click and drag the cursor, along the proposed route of your rail line to 
plan the route for rail you want to build.
Important    Be sure to survey before you build.



Survey Tracks button
Click this button, and then click mileposts, or click and drag your cursor, along the proposed route of your rail line 
to plan its route.
Important    Be sure to survey before you build.



Telegraph button

Click to display the Telegraph window, or just begin typing to display it. You can send your typed message to other 
players at any time during the game.



Telegraph button
Click to display the Telegraph window, or just begin typing to display it. You can send your typed message to other 
players at any time during the game.



Telegraph button
Click to display the Telegraph window, or just begin typing to display it. You can send your typed message to other 
players at any time during the game.



Telegraph window

Use this window to type messages to other players. 



Upgrade Train button

Click this button to see the Upgrade Train dialog box.



Upgrade Train button
Click to open the Upgrade Train dialog box.



Rail-Crossing Signal
This rail-crossing signal turns green when it's your turn to play.



City requesting a load
City will pay cash for the load specified by the load icon to the left of the city's name. To find out where you can 
pick up the load that the city needs, click the load icon.



Amount city will pay
Shows the dollar amount a city will pay you when you deliver the load it needs.



Face
In other Players windows, you'll see the faces of their characters. In Your Player window, you'll see your own. You 
can click your character's face to open the Select Face window, then choose a new face by clicking one.



Loads
Click the load icon to display where you can pick up and deliver loads.



Your current loads
Displays the current loads you have picked up and are hauling on your freight train.



Freight Train
In other Player's windows, you'll see the type of freight trains they have. In Your Player window, you'll see your 
own. You can upgrade your train to increase the number of loads it can carry and the number of mileposts it can 
move per turn. To upgrade your train, click the Upgrade Train button and pay $20 million for each upgrade.



Your Player window

This window shows your character, locomotive, and the amount of cash (in millions) you currently have. It also 
shows a rail-crossing signal that rises and a light that turns green when it's your turn to play.



Play Game button

Click to play a game after you have defined its rules, invited other players to it, and selected it in the Global Game 
List window. A circle with a bar is displayed if no game is selected, or if the game was created by another player and
has not yet started.



Load Game button

Click to open the Talk window to invite players to a game that you have created but not yet started.



Create Game button

Click to define rules of a new game.



Start Game button

Click to start playing a game after you have defined its rules.



Theater Help button

Click to open online Help for the MPG-Net Theater. To open online Help for a specific game, you must be playing 
it.



Moving at half-speed during a storm
Some reported disasters, such as bad weather, will force you to operate your train at half speed. 
During storms, freight and heavy freight move 5 mileposts per turn; fast freight and superfreight move 6 mileposts. 
If you begin your turn at full speed, and then enter an area where you must move at half speed, divide your 
remaining moves by two and round up.
For example, with a freight train, you can normally move 9 mileposts per turn. But if your freight train enters a 
storm when you have 5 moves remaining, you'll be allowed to move only 3 more. (Divide 5 moves by 2 and round 
up to 3 moves.)
Note    After you leave a half-speed area, you must still move at half speed for the remainder of your turn. 



Mopping up after a flood
When a river floods, all tracks (regardless of who owns them) bridging that river are washed away. 
Important    You and the other players will need to rebuild the lost tracks after the disaster is over. If you forget to 
rebuild, your train will be stuck at the river the next time you try to pass that way.



No movement disasters
Some disasters do not allow you to move from milepost to milepost within a certain area, but they do allow you to 
move from a milepost within the disaster area to a milepost outside the area, if tracks are built to outside the area.




